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Installing HotDocs

What Is HotDocs?

HotDocs is an award-winning software application that significantly reduces the time spent generating
customized documents, such as contracts, sales proposals, government and court forms, legal
documents, loan applications, and medical forms.

Using HotDocs, you can transform any word processor file into an interactive template by marking
changeable text with HotDocs variables. Then, the next time you want to generate a completed text
document, just assemble the interactive template you've created. As you do this, you will be prompted for
the information needed in the document and that information will be merged into the document.

When using HotDocs, you can perfect a template, minimizing the "human error" factor that repetitive
typing introduces. Additionally, you can automate your templates so that verb tenses, gender references,
dates, numbers, calculations, and more are updated automatically as users enter information. Custom
interview questions and help resources guide you or your users through the interview.

Virtually any document in your workflow can be converted to a HotDocs template, including lengthy and
complex documents. HotDocs templates then become your gold standard—experienced colleagues can
share their knowledge, and new colleagues come up to speed faster. Using HotDocs, you can compile an
invaluable repository of special language, unigue clauses or terms, correspondence, and more.

The following diagram shows the HotDocs process, from template development to document assembly:

Template Development Document Assembly
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System Requirements

To ensure the best performance using HotDocs, please note the following requirements for hardware and
software:

Hardware

= 900 MHz processor (2GHz, recommended)

=« 256 MB RAM

= 25 MB hard disk storage

= 1024 x 768 screen resolution with at least 16-bit color

Software

= Microsoft Windows 2000 (SP3 or higher), Windows XP, or Windows Vista

= Microsoft Internet Explorer 6.0 or later

= Microsoft Word 97, 2000, XP, 2003, or 2007

= Corel WordPerfect 8, 9, 10, 11, 12, X3, or X4
+ Caution: Microsoft Word 97 is not supported for use with HotDocs on Windows Vista. Additionally,
+ WordPerfect X3 SP2 and later are the only versions of WordPerfect supported for use on Windows
+ Vista.

Databases

If you plan to integrate HotDocs with a database, you must have one of the following applications or
servers installed:

« Microsoft Access

= Microsoft SQL Server

« Oracle 8i or 9i with the OraOLEDB OLEDB provider
« Most other ODBC-compliant database
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Install HotDocs

When you download the HotDocs Player and run the executable, HotDocs prompts you for all of the
information it needs to complete the process.

Before installing HotDocs, make sure your computer meets the minimum requirements necessary for
using HotDocs. (See System Requirements.)

To install HotDocs

1. Close all open programs, especially any word processors or existing versions of HotDocs you may
have open.

2. Insert the HotDocs installation CD into your CD-ROM drive. The CD browser window appears.
3. Click Install HotDocs Player Edition . The installation program begins installing HotDocs.

4. Follow the on-screen prompts to complete the installation.

« To manually install HotDocs, select Run from the Start menu and type D:\setup. (Substitute the

correct drive letter if your CD-ROM drive is not mapped to D:\.) Follow the on-screen prompts to
complete the installation.

« For a description of how HotDocs is installed, see Understand HotDocs Installation.
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Understand HotDocs Installation

When you install HotDocs, two different installations actually happen—the HotDocs Setup and the
Current User Setup. This two-part installation process not only allows the program be installed just once
for multiple users on a single workstation, but it also allows each user who logs on to the workstation to
have his or her own custom files and settings.

HotDocs Setup

When you first install HotDocs from Setup.exe (see Install HotDocs), HotDocs installs the program files
needed to use HotDocs, including any executable files used to run HotDocs. Among others, it also installs
the HotDocs Help files. These files are installed, by default, to C:\Program Files\HotDocs 6. This location
is not user-specific, which allows all users of a single workstation access to the files.

As HotDocs installs these files, it registers information about them in the Local Machine key of the
Windows System Registry. For example, the Registry stores information about where the executable
file for HotDocs is located on disk, as well as which word processors HotDocs supports. It also sets
some preliminary file location information for the various files HotDocs uses, including information about
library files and template set files. All of this information must be registered in order for HotDocs to work
correctly.

Current User Setup

When you install HotDocs, the installation creates a folder named Source in the HotDocs program folder.
This folder contains several files, including word processor macro or startup files and the user spell-
checking dictionary. These files must be in user-specific folders on the disk. However, because multiple
users may use a single workstation, HotDocs Setup doesn't install these files. Instead, when a user logs
on to the workstation and runs HotDocs, the Current User Setup copies these files to the correct locations
for the user. (See Default File Locations in HotDocs 2008.)

The Current User Setup also registers information about each user in the Current User key of the System
Registry. This information includes default file locations for such things as templates, answer files, and
library files. As each user specifies preferences for working with HotDocs, these settings are likewise
written to the Current User key. This allows each workstation user to have his or her own HotDocs
settings without other users overriding those preferences with their own.

The Current User Setup happens each time a user starts HotDocs. This means that each time you run
HotDocs, HotDocs checks to make sure all of the required files (such as word processor startup files) are
located where it expects to find them. If the file isn’'t found, HotDocs replaces it using a copy it finds in the
Source folder.

Restore Installation Defaults

At times, you may want to restore default settings in HotDocs. You can accomplish this by clearing the
Current User key of the Registry.
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Default File Locations in HotDocs 2008

When you install and use HotDocs, the program makes several entries in the System Registry that
indicate to HotDocs where to look for files, as well as where to suggest you save files. (See Understand
HotDocs Installation.) In most situations, HotDocs uses this information each time you perform a task in
HotDocs. For example, each time you create a new template, HotDocs suggests a default location for the
new template, based on the information it finds in the System Registry.

The following is a list of these default locations:

..............................................

........................................................................

+ Caution: In Windows Vista, the My Documents folder has been renamed as Documents. The All
+ Users Documents folder has been renamed as Public Documents.

..............................................

File Type

Program Files

Help Files

Spelling Dictionary File
Library Files

Template Files

WordPerfect Macro Files
MS Word Startup Files
Template Sets

Text Document Files
Form Document Files
Answer Files

Catalog Files

........................................................................

Default Location

C:\Program Files\HotDocs 6
Program Files\HotDocs 6

My Documents\HotDocs\Spelling
My Documents\HotDocs\Libraries
My Documents\HotDocs\Templates

Even though HotDocs saves all template
types to this folder, it still maintains separate
default settings for text templates, form
templates, and interview templates.

Word Processor Macro Folder

Word Processor Startup Folder

All Users Documents\HotDocs\Templates
Word Processor Documents Folder

My Documents

My Documents\HotDocs\Answers

All Users Documents\HotDocs\Catalogs

If you need to change these default locations after HotDocs is installed, you can do so at HotDocs

Options.

+ Caution:

= If you are upgrading from HotDocs 6.1 or earlier and your libraries are saved in the HotDocs 6
Program Files folder, HotDocs will set this folder as the default location for libraries. If you do not
have library files saved here, HotDocs will use My Documents\HotDocs\Libraries.

= If you perform a custom installation, HotDocs will install files and set registry entries using the
information you specify during installation. Whatever settings you specify during installation will

be used for all users of the workstation.
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Uninstall HotDocs

You can remove existing versions of HotDocs from your computer by using the HotDocs uninstall
program. When you uninstall, all of the program files are removed from your computer. However, the
program does not remove any custom templates, libraries, or answer files you have created.

To uninstall HotDocs
1. Atthe Start menu, select Settings > Control Panel. The Control Panel dialog box appears.
2. Click Add or Remove Programs. The Add or Remove Programs dialog box appears.

3. Select the version of HotDocs that needs to be removed, then click Remove. The HotDocs uninstall
process starts.

4. Follow the on-screen prompts to remove the program.

......................................................................................................................

+ Caution: If you plan to reinstall HotDocs to restore default settings, you must delete the user-specific
+ settings HotDocs entered in the Windows System Registry.

......................................................................................................................
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Working with Assembled Form Documents

Overview: Assemble a Form Document

In most cases, you assemble a form document exactly as you assemble a text document. However, HotDocs
form documents provide some additional capabilities. For example, you can enter answers directly in the form
document, moving from field to field. You can also print a blank copy of the form that can be completed by
hand. Finally, you can create and modify an addendum to save answers that require more space than the
form provides.

10
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Enter Answers Directly at the Form Document Tab

When assembling text documents, you answer questions in the interview and those answers are merged
into the document. When assembling form documents, however, you can either enter your answers in the
interview or you can enter your answers directly on the form document. This latter method of assembly

is called direct-fill assembly. In some cases, the template provider designs templates so that the only
method for assembily is by direct-fill.

To enter your answers directly into the fields

1.

2.

At the HotDocs library window, select a form template and begin assembling the document.

If you're not viewing it, click the Form Document tab. The assembly window changes to show the

form document.

Click on a field and enter an answer.

Press Tab to move to the next field, or use the mouse to click on another field.

As you tab between fields, HotDocs will skip any conditioned fields that have been resolved in such

a way that it isn't necessary to answer the field.

Optionally, you can perform any of the following tasks:

To
Create a new field on the document

Add additional answers to a table

Answer questions that compute the answer
for afield or control the inclusion of other
answers

Show or hide the colored fields

Quickly browse through the pages of a form
document

Jump to a specific page of the assembled
document

Do This

Click the h.‘ Select Tool button and draw the
field. (See Create a Form Field.) To enter text

in the field click on the l':[_—l Fill Tool and then
click in the field.

If the template developer has included it, click

the % Table Wizard button next to the field.

If the template developer has included it, click

[, o]
the =% Answer Wizard button next to the
field.

Click the él? Show Fields button.

o
Click the -Jl_-l Show Thumbnails button. This
displays small images of each page in the
document in the left margin of the form view.
You can click one of these images and go to
that page immediately.

Choose Go To (Edit menu) and enter the page
number of the page you want to view.

11
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Move through the answers in a document Place your cursor in a field and click one of
the following navigation buttons: (If the Form
Navigation Bar isn't showing, choose it at the
View menu.)

Clicking ’ Next or ‘ Previous moves
you to the next or previous answer in the
document.

Clicking the L Next Unanswered or 4
Previous Unanswered button moves you
to the next unanswered question in the
document

= Pressing Ctrl+M or Shift+Ctrl+M moves
between matching answers in the
document (for example, those answers

in the document that are exact matches).
(You can also press Shift as you click the

" Next or " Previous button.)

Clicking M End or M Beginning to
go to the end of the document or the
beginning of the document.

= To access answer wizards, table wizards, and calendars during direct-fill assembly, right-click on
the field and choose the option from the shortcut menu. For example, to view the calendar for a
date field, right-click on the field and choose Calendar from the shortcut menu.

= Some answers may be too large to fit in the field. If this happens, HotDocs warns you by
displaying the Overflow Options dialog box. See Check Form Fields for Answer Overflow.
Similarly, you can specify when this warning should appear.

12



Assembling HotDocs Documents

View the Assembled Form Document

Before saving the assembled form document, it is a good idea to review the document. You can do this at
the Form Document tab of the assembly window. Doing this allows you to make changes to answers in
the document and have those changes automatically updated in the answer file.

To view assembled form documents

1.
2.

At the HotDocs library window, select a template and begin assembling the document.

After answering the questions in the interview, click the Form Document tab. The assembly window
changes to show the assembled document.

Optionally, select a field and enter a different answer. (See Enter Answers Directly at the Form
Document Tab.)

Once you have finished entering answers, complete any of the following options:

. Click the E Save Document button to save the assembled form document to disk. (See
Save an Assembled Text or Form Document.)

. Click the j Print Document button to print the assembled form document. (See Print an
Assembled Form Document.)
Click Send Document To > Mail Recipient (File menu)to attach the assembled form
= document to an e-mail message.
Click Close (File menu) to close the assembly window. HotDocs prompts you to save any
=« changed answers.

See Overview: Assemble a Form Document for a list of changes you can make to an

assembled form document.

13
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Override an Answer in a Form

In a HotDocs form document, fields are designed to hold certain types or formats of information. However,
there may be times when you need to enter a type of answer that HotDocs won't allow. You can override
the field type and enter any answer you need.

For example, a field with a Number variable attached to it is designed to hold only digits. However, if the
number you enter (say, £325,000,000) is too large for the field, but you don't want to send the answer to
the addendum, you can override the field and enter £325 m.

Answers entered in overridden fields are not saved in the answer file. The original answer is saved in the
answer file and used in any computations or other fields that require it.

To override an answer
1. Atthe HotDocs library window, select a form template and begin assembling the document.

2. After entering answers, click the Form Document tab. The assembly window changes to show the
document.

3. Select the field you want to override.

Click the E: Override Field button and, at the Override Field warning message, click OK. The
assembly window appears again.

5. In the field, enter the answer you want, then move to a different field. The overridden field changes
to gray.

To remove the overridden answer, select the field and click the =45 Override Field button again. The
current answer is removed and the saved answer reappears. Removing the override, however, may
create answer overflow situations. See Check Form Fields for Answer Overflow for details.

14
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Print an Assembled Form Document

Many projects require you to print copies of assembled form documents. The options available for printing
a form depend on which type of form you are printing. Specifically, you can print:

= HotDocs form documents (or .HFDs).
= HotDocs PDF documents (or .HPDs).

To print a form document

1.
2.

5.

At the HotDocs library window, select a template and begin assembling the document.

After providing the required answers, click the Form Document tab. The assembly window changes
to show the assembled document.

Click the (5§ Print Document button.

If you are printing a HotDocs form document (or .HFD file), select any of the following printing
options. (If you're printing a PDF form document, skip to step #5.)
To print the form and answers, select Form with Answers in the Output group.
= To print only the static text of the form, select Form Only (Blank Form) in the Output group.
= To print the answers onto a pre-printed copy of the form, select Answers Only (Use
= Preprinted Form) in the Output group.
To change the double-sided printing options, select the desired option. Single-sided prints
= the document using one side of each sheet of paper. Double-Sided, Side-to-Side prints the
document with the tops of both pages at the same end of the paper, like a traditional book.
Double-Sided, Top-to-Bottom, prints the document with the bottom of the second page at the
same end as the top of the first page, like a flip-chart.

If you are printing a PDF form document (or .HPD file), you must choose whether to print using
the functionality of HotDocs or Adobe Acrobat.

Choose HotDocs, which prints at a slower speed but provides a wider range of printing
= options.
Choose Adobe Acrobat, which prints at a faster speed but provides few printing options.

Some types of printers have been known to cause problems when printing a form template or document,
and should be tested before use with finished products. These printers include:

Ink jet printers

Brother printers

16-bit postscript printer drivers

DeskJet printers

Xerox printers

"All-in-one" printers (printers that include copying, scanning, printing, and faxing capabilities)

For best results, it is recommended that you use an HP LaserJet with at least two megabytes of memory.

15
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Choose Default Form Printing Options for a Form

Different forms may require different printing settings. You can specify that a form should be printed
single-sided, double-sided side-to-side, or double-sided top-to-bottom. You can also control what size of
paper to use as well as which paper tray should feed the paper to the printer.

The option you specify is set as the default in the Print dialog box, but you can select a different option.
To specify form printing options

1. Edit a form document. (See Edit a Saved Form Document.)

2. Click File > Document Properties > Printing. The Printing Properties dialog box appears.

3. Select the printing settings from the following options:

= Single-sided prints the document using one side of each sheet of paper (default setting).

= Double-sided, side-to-side prints the document double-sided, with the tops of both pages at
the same end of the paper. (This option allows you to turn through the pages like a traditional
book.)

= Double-sided, top-to-bottom prints the document double-sided with the bottom of the second
page at the same end as the top of the first page. (This option allows you to turn through the
pages like a flip chart.)

= Paper size specifies the dimensions of the paper used to print the document.

= Paper source specifies what tray of paper is used to print the document.

You can use command-line options to control the paper size and paper source.

16
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Edit a Saved Form Document

After assembling a form document, you often need to save the document to disk. Once saved, you can

re-open the document using HotDocs Filler.

Once a form document is saved to disk, it is no longer associated with the answer file. This means that
changes you make to answers in the document do not affect the answer file. If you want to save changes
you're making to the answers, re-assemble the form document and change your answers in the interview.

Then save your answer file again.

To work with a saved form document in Filler

1. Using Windows Explorer, locate and double-click the appropriate form document. HotDocs Filler

appears, showing the form document.

2. Optionally, you can perform any of the following tasks:

To
Change an answer in a field

Create new fields

Print the document

Open a different HotDocs form file

Do This

Click on a field. The field becomes active,
allowing you to enter an answer.

i Caution: You can edit answers in a saved
i form document, but you must re-evaluate

i any computations or conditions affected by
i changed answers. Similarly, changes you

i make are not reflected in the answer file

i used to assemble the document.

......................................................

With the h.‘ Select Tool button selected, press
the left mouse button and move the mouse
pointer to draw a rectangle. To type in this field,

select the .-I_—. Fill Tool button.

The fields you create in Filler have no variable
associated with them. They are simply text
boxes where you can type information.

Click the j Print button.

=]
Click the == Open button, and then locate the
desired file. (You can also press Ctrl+0.)

3. Once you have the assembled form document open for editing, there are several other things you

can do. For example, you can:
= Change the field type.

= Change the size of a field. (See Resize Form Fields.)
= Change the position or margins of a field. (See Move a Field on a Form and Change the

Borders and Margins of a Field.)

= Create a new answer field. (See Create a Form Field.)
= Rotate text in a field. (See Rotate Answers in a Field.)
= Convert answers on the form to bar code format. (See Convert Answers on the Form to Bar

Code Format.)

17
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= Insert a graphic into a field. (See Insert a Graphic File in a Form.)
= Cross out static text on the form. (See Cross Out Static Text on the Form.)
= Circle static text on a form. (See Circle Static Text on a Form.)

18
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Create a Form Field
You can create a form field on an assembled form document.

When you create a field, HotDocs determines the type of field you are creating based on the size of the
field—if a field is smaller than a certain dimension, HotDocs creates a check-box field. If a field is larger,
then it creates an edit field. (You can define these dimensions at HotDocs Options.)

Sometimes when you create a field, HotDocs can detect the borders of the underlying form and adjust
its size to fit within those borders. This helps ensure the field fits best in the space allotted. See Detect
Borders to Create or Resize a Field.

Once afield is created, you can enter any text you need in it.
To create a form field

1. Edit a form document. (See Edit a Saved Form Document.)

n

Click the h‘ Select Tool button.
Position the mouse pointer at one end of the intended field.
Press and hold down the left mouse button, then drag the pointer to the opposite corner of the field.

Release the mouse pointer. The field is created.

o o M w

Optionally, click Detect to have HotDocs adjust the size of the field to more closely match the
underlying static line or lines.

7. Optionally, you can customize the appearance of your fields in the following ways:
= Change the field type.
= Adjust the size. (See Resize Form Fields.)
= Change the field's position on the form. (See Move a Field on a Form.)

= To move multiple fields once they have been created, select the fields and press the arrow key
that indicates which direction you want to move them. To move fields more quickly, press the
Shift key while pressing the arrow keys.

= You can also create a standard-size field by double-clicking on the form. Or, you can click to set
the field cross-hair and press F8.

19



Assembling HotDocs Documents

Select a Field

In order to work with a field, you must first select it. When you select a field, handles appear on the field
borders showing that you can edit the borders or other properties. You can select a single field to work
with, or you can select multiple fields to group them or to make the same change to all of the fields.

To select fields
1. Edit a form document. (See Edit a Saved Form Document.)

2. h‘
Click the Select Tool button

3. Click on the field you want to work with.

4. Optionally, to select multiple fields, either press the Ctrl key while clicking each field, or press the
Shift key, then press the mouse button and drag the mouse pointer to create a bounding frame. All
fields included in or touched by this frame will be selected.

5. Use any of the following additional methods for selecting fields or canceling the selection, as
described in the following table:

To Do This

Select all the fields on the current page Click Select All (Edit menu). (You can also
press Ctrl+A.)

Cancel the selection of all selected fields Click outside the fields, or press the Esc key.

Cancel the selection of only one of a group Hold down the Ctrl key and click that field.
of selected fields

Add fields to your group of selected fields Hold down the Ctrl key and click the new fields.
without canceling the selection of those
already selected

= If you have trouble selecting the field you want, the field may be in a group. If this is the case,
you must first ungroup the fields by clicking Ungroup (Field menu). (See Ungroup Form Fields.)

) Click the él? Show Fields button to show and hide field colors.
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Detect Borders to Create or Resize a Field

When you create fields on a form, you often use the underlying static text as a guide as to where the field
should be placed. Often, you want the borders of the fields to match the borders of the static text. To help

you align these borders, you can use the 'K’ Detect feature. This feature is useful both when you create
a new field and when you need to resize a field to fit within its allotted space.

If HotDocs is unable to automatically create or resize a field to the size and position you want, you must
create the field manually. Several factors may contribute to these difficulties:

= Insufficient surrounding features: To detect a field, HotDocs searches for surrounding features,
such as lines, text, or graphics. If there are insufficient surrounding features, HotDocs may have
difficulty detecting a field. In such cases, HotDocs creates a field of the default size.

= Label text: When label text is inside the field area and there is enough space between the text and

the bottom of the field area, the "K' Detect command will extend the field up to the bottom of the
label text. If you want the field to occupy the area to the left or right of the label, or if you want to
include the label inside the field, you must create the field manually.

= Field not completely visible: If part of the intended field is not visible (for example, it's scrolled
out of the window), HotDocs attempts to scroll to detect the field. It is recommended that you use a

zoom level such as I‘:] Fit Page to Width so HotDocs can find the entire field on the screen.
To detect the borders of the underlying static text
1. Edit a form document. (See Edit a Saved Form Document.)

2. On the form, complete one of the following steps:
« If the field is already created, select the field and choose Detect (Field menu).
« If you are creating a new field, place your cursor where the new field should be created and

choose Detect (Field menu).
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Move a Field on a Form

As you create fields on a form, you will frequently need to move the fields. You can do this using the
mouse or keyboard. You can also specify a precise location using the Field Properties dialog box.

To move a field using the mouse

1.
2.
3.

Edit a form document. (See Edit a Saved Form Document.)
Position the mouse pointer over the selected field. The cursor changes.

Hold down the mouse button and drag the field to the new position.

To move a field using the keyboard

1.
2.
3.

Edit a form document. (See Edit a Saved Form Document.)
Select a field. (See Select a Field.)

Press the arrow keys to move the field one unit of measurement in that direction. (To move the field
more quickly, hold down the Shift key as you press the arrow keys.)

To move a field using the Position/Size dialog box

1.
2.
3.

Edit a form template. Edit a form document. (See Edit a Saved Form Document.)

Select a field. (See Select a Field.)

E:
Click the 231 Field Properties button. The Field Properties dialog box appears.
Click the Order/Size tab. The view changes to show the positioning options.

In the Position group, enter the desired distance from the left and top margins of the page in
the Left and Top boxes. (You can also click the up or down arrows for each field to change the
distance.)

= If afield you want to move is part of a group, you must first ungroup the fields. (See Ungroup
Form Fields.)

= The Field Properties dialog box includes the First, Previous, Next, and Last buttons to move
you between fields. When you have multiple fields selected, these buttons are not available.
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Change the Borders and Margins of a Field

You can change the borders and margins of a form template field. Borders control the thickness of the
field box, and margins control the distance between the border of the field and the answer text.

To change field borders or margins
1. Edit a form document. (See Edit a Saved Form Document.)
2. Select the field whose borders or margins you want to change.

3. r:
Click the 23 Field Properties button. The Field Properties dialog box appears.

4. Click the Layout tab. The view changes to show layout options.

5. In the Borders and Margins groupings, make your selections. (Remember, borders affect the
thickness of field boxes, while margins affect the distance between the border of the field and the
answer in the field.)
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Copy One or More Form Fields

Frequently, you need to copy fields on a form. For example, say you need to create a group of fields that
all have the same properties. Rather than creating each field individually and modifying its properties, you
can create a single field, assign the properties, and then copy the field to create the others in the group.

When a field is copied to a new place in the same template, all the field’s properties (size, font, line
formatting, fill order, etc.) are copied with it.

When you copy fields to a new location, the cursor position tells HotDocs where to paste the copied fields.
If you copy a single field, the lower-left corner of the field will be at the cursor position. Likewise, if you
copy two or more fields at the same time, the lower-left corner of an invisible boundary box drawn around
all of the copied fields will be at the cursor position. If there is no cursor, the field is pasted on top of the
original.

You can copy fields on only one page at a time.
To copy and paste one or more fields
1. Edit a form document. (See Edit a Saved Form Document.)
2. Select the field or fields you want to copy. (See Select a Field.)

3. Choose Copy (Edit menu). The field is copied to the Windows Clipboard. (You can also select the
field and press Ctrl+C, or you can right-click on the field and choose Copy from the shortcut menu.)

4. Place the mouse cursor where you want the lower-left corner of the copied field to be, and then click
the mouse to set the cross-hair.

5. Choose Paste (Edit menu). The copied field is pasted at that location. (You can also press Ctrl+V,
or you can right-click on the field and choose Paste from the shortcut menu.)

You can also copy a field by holding down the Ctrl key while dragging the field to its new
location.
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Resize Form Fields

You may need to adjust the size of a field to fit it into the available space on the form. You can change a
field's size using the mouse, the keyboard, or the Position/Size tab of the Field Properties dialog box.

To resize afield using a mouse
1. Edit a form document. (See Edit a Saved Form Document.)
2. Select the field. (See Select a Field.)

3. Click a handle or field border. (When the mouse pointer is on a handle, the pointer changes to a
double-arrow, indicating the directions the border can be moved.)

4. Hold down the mouse button and drag the border to a new position.
To resize afield using the keyboard

1. Edit a form document. (See Edit a Saved Form Document.)

2. Select the field. (See Select a Field.)

3. Press the Page Up or Page Down keys to move the top border of the field up or down, and the End
or Home keys to move the right border of the field right or left. (To resize the field more quickly, hold
down the Shift key as you press the keys.)

To resize afield using the Field Properties dialog box
1. Edit a form document. (See Edit a Saved Form Document.)

2. Select the field. (See Select a Field.)

3. r:
Click the 231 Field Properties button. The Field Properties dialog box appears.

4. Click the Order/Size tab and, in the Size group, enter the desired distance from the left and top
borders of the field in the Width or Height boxes. (You can also click the up or down arrows for
each field to change the size.) The field size is changed.
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Change the Tab Order of Fields

When determining the order to ask questions in the interview, HotDocs begins with the top-left field of
the form and processes all of the fields until it reaches the bottom-right field. This processing affects two
things—the order questions are asked in the default interview and the order in which the user is able to
tab through fields on the form.

Because of this default field ordering, sometimes you may find the tab order of fields to be incorrect. You
can change this order.

Once you specify a fill order for one field, you must specify the order for every field you want
processed after that field. In effect, when you specify a fill order for just one field, you set that field to
be answered last. This is because all the other fields are still set to Row 0, Column 0—they are lower
than the Row 1 or Column 1, so they will be filled first. Therefore, to change the order of the fields in
the middle of the form, you must also change the order for every remaining field.

The following rules control field ordering:

« Fill order is determined first by row, then by column.

« All field values are initially set the same—Row 0, Column 0.

« When fields have different row numbers, fields with lower row numbers are asked first, for example,
Row 0, Column 0; Row 1, Column O; etc.

= When fields have the same row numbers, but different column numbers, fields with lower column
numbers are asked first, for example, Row 1, Column 0; Row 1, Column 1; etc.

« Fill order is treated separately for each page of the template—you cannot specify a fill order that
runs from one page to another.

To change the tab order for fields
1. Edit a form document. (See Edit a Saved Form Document.)

2. Select the field. (See Select a Field.)

3. .

Click the &3 Field Properties button. The Field Properties dialog box appears.
Click the Order/Size tab. The view changes to show ordering options.
In the Row box, type the row number.

If you need to specify the order for fields in the same row, type a number in the Column box.

N oo g &

Optionally, at the Order dialog box, you can click the First, Previous, Next, or Last button to save
the current field's settings and display the next field's order.

By selecting and ordering different groups of fields, you can use fill order to handle various situations. For
example:

= Remove all fill order settings: Select all fields and set the Row and Column numbers to 0.

= Organize large sections of fields: Select the desired fields and specify the order.

= Flow answers across fields contrary to the default order (top to bottom, left to right): Set the
desired order, then group the fields. (See Group Form Fields So Answers Can Flow From One Field
to Another.)

= Fill table columns in an order different from the static text: Set the desired order, then group the
fields as a table.
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Group Form Fields So Answers Can Flow From One Field to Another

Sometimes an answer must begin in one field and continue in other fields. For example, you may have
an answer that must span two or more pre-printed lines. You can create edit fields for each line, and then
group the fields so that answers flow from one field to another. Fields grouped this way are called run-on
groups.

Once fields are grouped, HotDocs treats the group as a single field.

To flow an answer across multiple fields

Edit a form document. (See Edit a Saved Form Document.)

Create all the text fields across which the answer should flow. (See Create a Form Field.)

Select all the fields that will be used for the answer. (See Select a Field.)

A W DN BE

Click Group (Field menu). A bounding frame appears around the grouped fields. (You can also
right-click and select Group from the shortcut menu.)

Caution: When fields are grouped, you cannot change properties for individual fields. You must first
+ ungroup the fields. (See Ungroup Form Fields.)

......................................................................................................................

27



Assembling HotDocs Documents

Ungroup Form Fields
When fields are grouped, you cannot modify the individual fields. You must first ungroup the fields.
To ungroup the fields

1. Edit a form document. (See Edit a Saved Form Document.)

2. Select one of the grouped fields. The whole group is selected. (See Select a Field.)

3. Click Ungroup (Field menu). (You can also right-click on the field and choose Ungroup from the
shortcut menu.)

Some properties that were assigned to the group, such as text, margin, and line format properties
remain applied to the individual fields that made up the group. Other properties, such as a field order or
a condition, are lost until you regroup the fields. Regrouping the fields restores the properties that were
previously applied to the group.
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Change the Font Used for a Field

You can choose the font that is used for answers on a form. When choosing the font, you can also
indicate the style (for example, bold or italics), size, effects, and color that are used.

As is always the case when working with fonts, if the form requires a specific font be used, you must
ensure the font is installed on all computers where the form will be viewed.

To change the font for a field or group of fields

1.
2.
3.

Edit a form document. (See Edit a Saved Form Document.)

Select the field or fields whose font you want to change.

E:
Click the 23 Field Properties button. The Field Properties dialog box appears.
At the Type tab, click Font. The Font dialog box appears.

Make your font selections.

You can specify default font properties for all new fields you create at HotDocs Options.
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Format Lines and Paragraphs of Text in a Form Field

Sometimes you need to format the text within a multi-line text field. For example, perhaps you need to
indent the first line of a paragraph, or maybe you need to adjust the number of lines that fit in an inch of
vertical space. To do this, you can adjust the line format of a field.

To format lines and paragraphs

1.
2.
3.

Edit a form document. (See Edit a Saved Form Document.)

Create a multi-line field.

E:
With the field selected, click the 29 Field Properties button. The Field Properties dialog box

appears.

Click the Layout tab. The view changes to show the different options for formatting the field.

In the Line Format group, complete one of the following options:

To
Indent the first line of text in the paragraph

Force a certain number of lines to appear in
an inch of space in the field

Indicate how many lines can appear in the
field

Indicate the maximum number of characters
that can appear in a given line of text

Do This

Enter how much space to include between the
margin of the field and the first character of the
answer in the First line indent box. (You can
either type the number or click the up or down
arrows.)

Enter the number of lines in the Lines per inch
box.

Enter the number of lines in the Maximum lines
box. If the answer contains more lines than is
specified, the field will overflow.

Enter the number of characters in the Max
chars/line box. When the number of characters
exceeds this limit, text will wrap to the next line.
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Rotate Answers in a Field

By default, answers in fields appear in horizontal rows and can be read from left to right. You can rotate
text so answers will read from bottom to top, top to bottom, or upside-down from right to left.

To rotate text in a field
1. Edit a form document. (See Edit a Saved Form Document.)
2. Select the fields you want to rotate. (See Select a Field.)

3. r:
Click the 23 Field Properties button. The Field Properties dialog box appears.

4. Click the Layout tab. The view changes to show field layout properties.

5. In the Rotation group, select a degree of rotation: 0°, 90°, 180°, or 270°, for example:

Full Mame 0°

Full Mame 207
048 AWEN (N4

08} SLERN [n4
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Keep Contents of Form Fields from Printing

Sometimes you want field text to appear on the form during direct-fill assembly, but you don't want the
text to appear when you print a copy of the form. You can select an option that keeps this text from

printing.
To designate that a field's contents shouldn't be printed
1. Edit a form document. (See Edit a Saved Form Document.)

2. Create or select the field whose text you want to appear only on the form.

3. r:
Click the 23 Field Properties button. The Field Properties dialog box appears.

4. Atthe Type tab, select Non-printing field.
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Cross Out Static Text on the Form

Sometimes a form includes static text that must be crossed out. For example, say a form includes a list of
medical conditions. Instructions on the form tell you to cross out any conditions that do not apply to you.
You could manually cross out these conditions once you've printed the form; however, HotDocs allows
you to create a strike-through field, which crosses out the text for you, depending on answers you enter
during the interview.

A strike-through field, which is transparent, overlays the static text. You can choose the character that will
be used to cross out the text.

To create a strike-through field in a form

Lo

Edit a form document. (See Edit a Saved Form Document.)

2. Create a field that covers the static text on the form. (See Create a Form Field.)

3. r:
Click the &3 Field Properties button. The Field Properties dialog box appears. (You can also
right-click and select Field Properties from the shortcut menu.)

4. Click the Type tab.

5. In the Field type group, select the type of field you want to associate with the strike-through field.

6. In the Display type group, select Strike-through.

7. In the Strike-through character box, enter the character you want to be used for crossing out the
text.

8. Optionally, click Font to change the font properties (perhaps to make the font size larger or smaller).

9. Close the Field Properties dialog box. The text on the form is crossed out.
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Circle Static Text on a Form

Sometimes instructions on a form ask users to circle a preprinted option. Rather than make users print
the form and manually circle the option using a pen, you can create a form field that overlays a circle on
the text. You can attach a variable to the field so that the user can select which option should be circled
during the interview. Creating circle fields not only preserves the professional look of the form, but allows
the answer associated with the selection to be saved in the answer file.

To create a field that circles text

1.
2.

N o A

Edit a form document. (See Edit a Saved Form Document.)

Create a field that covers the static option on the form you want to select. (See Create a Form
Field.)

e
Click the &3 Field Properties button. The Field Properties dialog box appears. (You can also
right-click and select Field Properties from the shortcut menu.)

Click the Type tab.
In the Field type group, select the type of field you want to associate with the circled field.
In the Display type group, select Circled.

Optionally, to control the width of the circle's border, click the Layout tab and change the Line
thickness in the Circle group.
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Insert a Graphic Filein a Form

Sometimes you may need to include an image on your form, such as a signature or seal. You can create
a field and assign as one of its properties a graphic file. Supported file formats include .JPG, .BMP,
and .PNG. Image files should be saved to the same folder as the template.

To create a graphic field without using a variable

1.
2.
3.

6.

Edit a form document. (See Edit a Saved Form Document.)

Create a field. (See Create a Form Field.)

re
With the field still selected, click the 2 Field Properties button. The Field Properties dialog box
appears.

At the Type tab, select Image from the Display type group.

)
Click the & Open button next to the Image file name box. The Open dialog box appears.

Locate and select the desired graphic file and click Open. The path and file name appear in the box.

The image is visible at the Form Document tab.

35



Assembling HotDocs Documents

Convert Answers on the Form to Bar Code Format

You can create a two-dimensional bar code field that displays a single answer or group of answers.

This may be useful if the organization to which you submit your documents requires certain data in the
document be in bar code format. This allows the organization to scan the information and save it in some
data retrieval system, such as a database.

For example, say you must submit a form to the court. When the court files the form, rather than manually
entering case information (such as party names, case numbers, etc.), it can simply scan the bar code and
have the information automatically entered in the system.

Typically, bar codes display data in a pattern of lines and formats, which should be readable by most
hand-held laser scanners or charge-coupled device (CCD) scanners. The scanner should be able to read
the size of the bars, which is 0.01 inch.

Use the following tips when working with bar codes:

= The format HotDocs uses for bar codes is PDF417, or Portable Data File 417. It is one of several
recognized 2-D bar code formats.

= Bar codes in HotDocs can store about 1,500 characters, including numbers and other standard text
symbols.

= Printing a form that has a bar code requires a high-density printer, such as a laser printer.

= Bar code fields can overflow, but all overflow properties assigned to the field are ignored. When too
much text is entered for a bar code, no bar code appears. If you are having trouble getting the bar
code to fit in the field, you can enlarge the field or reduce the field margins. (See Resize Form Fields
or Change the Borders and Margins of a Field.)

To create a bar code using predefined text

Lo

Edit a form document. (See Edit a Saved Form Document.)

N

. Create a field. (See Create a Form Field.)

E:
Click the 23 Field Properties button. The Field Properties dialog box appears.
4. Atthe Type tab, select Bar code.

5. Type the data you want encoded in the Bar code text box. As you type the text, HotDocs displays
the bar code in the underlying form field. (If you are entering a group of answers that must be
interpreted by the bar code scanner as individual answers, you must separate each answer with
some sort of delimiting character, such as a tilde (~) or vertical bar (]).)

For example, Aber dare County Court~4th Fl oor~Crown Buil di ngs~Green Street~
Aber dar e~\Wal es~CF44 7DW

= To access the Field Properties dialog box, you can also right-click and select Field Properties
from the shortcut menu.
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Flow a Single Answer Across Two or More Pages in a Form

At times, a single answer field will start at the bottom of one page and continue to the top of the next
page. However, HotDocs will not allow you to create a single field that spans across both pages. You can,
however, create two fields—one on each page—and then link them using the Group Fields command.

To group fields on separate pages

1.
2.
3.

Edit a form document. (See Edit a Saved Form Document.)

Create the first field in the series of spanned fields. (See Create a Form Field.)

E
Select the field and click the =3 Field Properties button. The Field Properties dialog box
appears.

Click the Overflow tab, and in the Group name box, enter a name. It can be any text as long as it is
the same for each field in the group.

On the following page(s), create the fields that will contain any overflow.

Repeat the preceding steps for each field in the group, using the same group name as you assigned
to the first field.

Now, answers that do not fit in the first field will overflow to the next field named in the group.
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Check Form Fields for Answer Overflow

HotDocs can compare the size of a field and the length of the answer. If an answer uses more space
than is available in that field, HotDocs warns you and lets you resolve the overflow. Your options for
resolving the overflow include reducing the answer's font size, sending answers to the addendum, editing
the answer, resizing the field in which the answer is merged, and overriding the field to enter a differently
formatted answer.

After you complete an interview, you can manually check for answer overflow. Also, when you direct-fill
assemble a form document, HotDocs automatically checks each field when you move to another field.
Finally, when you print a document, HotDocs checks for any unresolved answer overflows.

To manually check for field overflow

1.
2.

At the HotDocs library window, select a form template and begin assembling the document.

After answering the questions in each dialog, click the Form Document tab to view the assembled

document.

answer.

. Click Check for Overflow (Tools menu). HotDocs begins comparing the size of each field and

If an answer is too long, HotDocs selects the field and displays the Overflow Status dialog box.
Information about the status of any answers that overflow is displayed at the top of the dialog box.

Make adjustments as explained in the following table:

To

Reduce the answer's font size to the
minimum size allowed for the field

Send the answer to the addendum and insert
cross-reference text in the answer field

Change the text of the answer, such as
reduce the number of words in the answer

Make the answer field larger

Do This

Select Shrink the answer to fit in the field.
The answer's font size is reduced to a smaller
point size. If the answer still doesn't fit in the
answer field, you must choose another option
for resolving the overflow.

Select Send the answer to the addendum.
The answer is moved to the addendum.
HotDocs then merges text in the field that
indicates the answer can be found in the
addendum.

Select Split answer if you want only the part of
the answer that doesn't fit in the field to be sent
to the addendum.

Click Edit. HotDocs highlights the field that
contains the answer so you can edit the text.

Once you edit your answer, click back on the
Overflow Status dialog box to have HotDocs
recheck the overflow.

Click Resize. HotDocs selects the field so you
can click one of its handles to resize it.

Once you resize the answer field, click back
on the Overflow Status dialog box to have
HotDocs recheck the overflow.
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Override any settings or formats of the field

and enter any text in the field

Resolve the overflow at a later time

Resolve the overflow on your own

Click Override and enter the text you choose in

the field.

Overriding a field does not change the

original answer. In fact, HotDocs continues
to use the original answer in any calculations
or scripts that require it. It also saves the
original answer to the answer file. Choosing
to override a field simply allows you to define
only the text that needs to appear on the
form.

Once you override the answer field, click back
on the Overflow Status dialog box to have
HotDocs recheck the overflow.

Click Ignore. The Overflow Status dialog box
is closed and you are able to work with other
answer fields in the document. If you click on
the overflowing answer field again, or if you

check for answer overflow, you will be asked to

resolve the overflow again.

Choose Close. HotDocs highlights the

overflowing field so you can change the answer

in whatever way you choose.

Once you resolve the overflow, you can click Close to close the dialog box. Any other fields that overflow

will display a similar dialog box.

You can prevent HotDocs from checking for field overflow during assembly.
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Customize the Look of the Addendum

Sometimes when assembling a form document, an answer is too long for the form field. One way to
resolve this overflow is to send the overflowing text to an addendum, which is a section of the form
designed to display such answers. You can modify the appearance of the addendum—for example,

you can choose what page margins to use, define what text appears in the headers and footers, and
choose the font properties for the text that is used in the addendum. You can also define how pages are
numbered in the addendum.

To change the addendum format
1. Edit a form document. (See Edit a Saved Form Document.)
2. Click File > Document Properties > Addendum. The Addendum Properties dialog box appears.

3. Complete any of the following steps:

To Do This

Define how much white space there is Enter the dimensions in the Page margins
between the addendum page edges and the  group.
text in the addendum

Define the text that appears at the top of Enter the text in the Header text box.
each addendum page

Define the text that appears at the bottom of  Enter the text in the Footer text box.
each addendum page

Change the font properties (including font In the respective Header properties and
face, size, and style) of the header or footer  Footer properties groups, click the Font button
text and make the changes at the Font dialog box.

Define how much vertical space the header  In the respective Header properties and
or footer text requires Footer properties groups, enter a number in
the Height box.

Change the alignment of the header or footer In the respective Header properties and
text Footer properties groups, click the Alignment
button and choose your alignment option.

Define the font properties (including font In the Addendum entries group, click the Font
face, size, and style) for answers that appear button and make your changes at the Font

in the addendum dialog box.

Define how much space there should be In the Addendum entries group, enter a
between the addendum label and the answer number in the Indentation box.

Define how much space there should be In the Addendum entries group, enter a
between each answer in the addendum number in the Space between box.

Make the addendum appear as a pleading Select Number lines to format as pleading
paper paper.

Once an answer has been sent to the addendum, you cannot edit the actual addendum—you must either
modify your answers at the Form Document tab or Interview tab, or you must send the addendum to
the word processor (choose File > Send Addendum To > Word Processor). You can also send the
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addendum to the Windows Clipboard (choose File > Send Addendum To > Clipboard) to paste itinto a
different program for editing.
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Define Overflow Properties for a Regular Field

When an answer is too large to fit in its field, HotDocs, by default, warns you and asks how to handle the
overflow. You can customize the field overflow properties, controlling how HotDocs automatically handles
answer overflows.

For example, you can have HotDocs automatically create an addendum, where each answer that
overflows is sent. In the field that overflows, HotDocs can insert cross-reference text that points you to a
specific item in the addendum. You can designate the text that is used both for the cross-reference and
for the label in the addendum.

Another option is for you to have HotDocs automatically reduce the answer’s font size. You can set a
minimum point size and control if the answer is automatically reduced to this size before displaying an
overflow warning message. (In reducing the font size, be cautious, because others may find the smaller
size harder to read.) (See Change the Font Used for a Field.)

How you define overflow properties depends on the type of field you are creating. For example, in an
addendum, grouped fields are handled a little differently from regular fields.

To set overflow properties for regular fields
1. Edit a form document. (See Edit a Saved Form Document.)
2. Select the field whose overflow properties you want to define.

Click the Field Properties button and click the Overflow tab.

4. Complete any of the following steps:

To Do This
Automatically shrink an answer that Select Shrink answer as needed and enter a
overflows to a specific point size point size in the points box.

Automatically send an answer that overflows Select Send answer to addendum. (To

to the addendum send only part of a multi-line answer to the
addendum, select Split answer. (See Split a
Multi-Line Answer Between the Form and the

Addendum.)
Define the text that appears in the answer Enter the text in the Cross-reference text box.
field when an answer is sent to the
addendum
Define the text that identifies the answer Enter the text in the Addendum label text box.
once it has been sent to the addendum
Make an answer the first item on its Select Begin addendum entry on a new page.
addendum page
Make an answer the last item on its Select Begin new page following addendum
addendum page entry.
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Split a Multi-Line Answer Between the Form and the Addendum

When creating multi-line fields, you can select an overflow option that sends either all of the answer to the
addendum, or only the part of the answer that doesn't fit in the field to the addendum.

If you allow the user to choose whether to split the answer between the form and the addendum, you
can customize the reference and label text, based on their selection. For example, if the user chooses to
send the entire answer to the addendum, you can specify See Addendum 1 as the cross-reference text.
However, if the user chooses to send just part of the answer, you can specify Continued in Addendum 1
as the reference text.

To choose overflow options for a multi-line answer
1. Create a multi-line field. (See Create a Form Field.)

2. I
Select the field and click the =3 Field Properties button. The Field Properties dialog box

appears.
3. Click the Overflow tab. The view changes to show overflow options.

4. Complete any of the following steps:

To Do This

Always send the answer to the addendum Select Send answer to addendum.

NG PremEng tne Dses To send just the part of the answer that doesn't

fit in the field to the addendum, select Split

answer.
Specify the text that will be merged in the Enter the text in the Cross-reference text and
field as well as the addendum if the user Addendum label text boxes, respectively.

ciieeses st o sene D arelenel/ To specify alternate text that will be merged

in the field and addendum if the user chooses
to split the answer between the form and the
addendum, type a vertical bar (]) and then enter
the alternate text after the bar. For example:

Cross-reference text: See Addendum 1|
Continued in Addendum 1

Addendum label text: Addendum 1|(con't)
Addendum 1
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Answer Files: Saving Answer Files

Overview: Save Answers

When you assemble a document, you can save the answers you enter in an answer file, which can
then be used later to recreate the same document or assemble other documents that require the same
information.

For example, perhaps you are creating several estate planning documents that require much of the same
information, like names, addresses, and important dates. You can save your answers in an answer file
and then use that answer file when assembling other estate planning documents. This eliminates the
need to re-enter information you've already provided. Answer files can be saved as standard answer files
(\AANS), or as XML answer files ((LANX).
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Create an XML Answer File

At times, you may need to save answers to a database, a third-party program, or an Internet site using
HotDocs Server. HotDocs lets you save answer files in XML format so you can integrate your answers
with any of these types of programs.

To save an answer file in XML format

1.
2.

At the HotDocs library, select a template and assemble the document.

After completing the interview, click the Save Answers button. The Save Answer File dialog
box appears.

At the Type drop-down box, select HotDocs XML Answer File (.anx).

Enter a file name in the File name box. If you want to save the answer file in a folder other than the

Answers folder, click the .__;-!_ Browse button and select a location.

Enter a title in the Title box, and a description in the Description box. (The description will appear
at the Properties tab of the Answer File Manager. When searching for specific answer files, you can
search for text in the description.)

Click OK. The answers are saved with the .ANX file name extension.

. Caution: Only people who have a solid understanding of XML should attempt to manually modify the
. contents of an XML answer file. That said, XML answer files are text based, so they can be created

. and edited with any text editor. If you manually create an XML answer file, most answers can appear
. in any given order. However, answers that are part of a repeated dialog must appear in the same

. order as they appear in the dialog.

.....

.................................................................................................................
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Create a Default Answer File

When certain answers are used frequently in a specific document, you can have those answers
automatically inserted each time you assemble the document. To do this, create a default answer file for
that document.

A default answer file must be saved to the same folder as the template's component file. It must also have
the exact same file name as the component file, but the file name extension must be either .ANS or .ANX.
In most cases, the file name and path for the component file are identical to the file name and path for the
template file. (The exception would be if the template is pointing to a shared component file, in which case
you would use the shared component file name.) You can find this information on the Properties tab of
the HotDocs library window.

To create a default answer file for a document

1. Atthe HotDocs library window, select a template and begin assembling the document, using a new
answer file.

2. Type information for only the answers you want to be default answers.
Click the Save Answers button. The Save Answer File dialog box appears.

At the File name box, click the v Browse button and locate the folder that contains the
component file. Then type the same file name, followed by an answer file name extension
(either .ANS or .ANX). For example, if the component file is named Invoice.cmp, the answer file
name would be Invoice.ans.

5. In the Title box, type a name for the default answer file.
6. Optionally, in the Description box, type a description for the answer file.

The next time you assemble the document, HotDocs automatically inserts the answers from the default
answer file into the template's answer fields. You can then modify the answers as necessary and save a
new answer file. (See Create a New Answer File.)
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Suggest an Answer File for Every Assembly

You may use a certain answer file more frequently than any others. You can select an option that will
automatically suggest that answer file every time you assemble a document.

To suggest an answer file for every assembly

1.
At the HotDocs library window, select a template and click [:U Assemble. The Answer File
dialog box appears.

2. At
Click the == Open Answer File button. The Open Answer File dialog box appears.

" Choose an answer file and click = Select. The Answer File dialog box appears again.
4. Select Automatically select this answer file for use with the next assembly, then click OK.

The next time you assemble any document, the same answer file will automatically be selected at the

Answer File dialog box. To change the answer file, click the L Open Answer File button and choose
a different file.
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Save an Answer File During Assembly

While assembling a document, you can save the answers you have entered. This allows you to save your
work and perhaps start a different assembly without closing the assembly window. Saving answers also
allows you to use the information you enter with other templates, thus saving you time.

To save answers during assembly

1. Atthe HotDocs library window, select a template and begin assembling the document.

2. At the assembly window, click the Save Answers button. If you are using an existing answer
file, the new answers are saved. If you are using a new answer file, the Save Answer File dialog
box appears where you can perform any of the following tasks:

To
Choose the format for the answer file

Enter the file name

Enter the title that identifies the answer file
in Answer File Manager

Add information to help identify the file

Do This

Click the Type drop-down button and select an
answer file format. Your options include .ANS
(native HotDocs format) and .ANX (XML-based
format).

At the File name box, enter a name. When you
click OK, the answer file will be saved to the
default Answers folder and a reference to it will
be added to Answer File Manager.

To save the answers to a location other than the

default Answers folder, click the —-ﬂ Browse
button and navigate to the location.

At the Title box, enter a name or accept the
suggestion HotDocs makes.

At the Description box, type notes about

the answer file's purpose or contents. (The
description will appear at the Properties tab of
the Answer File Manager. When searching for
specific answer files, you can search for text in
the description.)

= See Overview: Use Answer Management for information on using Windows Explorer instead of

Answer File Manager.

The Save Answers button may be disabled because the template provider wants to
prevent the answer file from being altered. You can assemble a document using new answers,
but when you close the assembly window, the new answers are automatically discarded.
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Switch Answer Files During Assembly

While assembling a document, you may want to use another answer file. At any point during the
interview, you can select a different answer file, then continue the interview using the new answers.

To switch answer files

1.

At the HotDocs library window, select a template and begin assembling a document. (See Assemble
a Text or Form Document.)

During the interview, click L Open Answers. The Open Answer File dialog box appears.
(Depending on the file management settings you have selected, a Windows Explorer dialog box or a
window from your document management program may appear instead.)

i
Select an answer file and click < Open.

If prompted to save the old answers, click Save, Save As, or Don't Save, depending on your needs.
(See Save an Answer File During Assembly.)

The assembly window appears again, using the newly selected answer file.

When viewing the answer library, you can sort the answer files. To do this, select a folder and

A
click I.vlr Sort. To search for a specific answer file, select the Find check box, then type the text for
which you are searching in the text box.
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Attach an Answer File to an E-mail Message

After gathering information in an interview, you may need to send those answers to another user. You
can do this by attaching the answer file to an e-mail message.

......................................................................................................................

+ Caution: Internet-based e-mail services are not compatible with this feature. You must have an e-mail
+ program, such as Microsoft Outlook, installed on your computer.

......................................................................................................................

To attach an answer file to an e-mail message
1. Atthe HotDocs library window, select a template and begin assembly.

2. After completing the interview, click Send Answers To (File menu). The Send Answers to Mail
Recipient dialog box appears.

3. In the Attachment name box, enter a name for the answer file attachment. Make sure to leave the
file name extension on the attachment name.

4. Optionally, if you want the answers to be in XML format, select XML Format.

5. Click OK. HotDocs opens an e-mail message and attaches the answer file.
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Spell Check Answers

You can spell check text answers you have entered at any time during an interview.

To spell check your answers

1.
2.

At the HotDocs library window, select a template and begin assembling the document.

After providing the required answers, click the ? Check Spelling button. If HotDocs finds any
unrecognized words, the Check Spelling dialog box appears. In the Answer being checked box,
HotDocs shows a section of the text that contains the misspelled word, which is highlighted. Options
for working with the misspelled word appear below it.

Make your selection, based on the options described in the following table:

To

Ignore the current instance of the word and
continue spell checking

Ignore all instances of the word and
continue spell checking

Correct only the current instance of the word
and continue spell checking

Correct all instances of the misspelled word
and continue spell checking

Add the word to your personal dictionary so
that the spelling checker will not question
the word again

Display additional spelling alternatives for
the unrecognized word

Change your spell checking options, such
as which words the spelling checker looks
at and how it determines whether a word is a
possible replacement

Do This
Click Ignore.

Click Ignore All.

Select an existing replacement from the
Change to list (or type the replacement in the
Change to box) and click Change.

Select an existing replacement from the
Change to list (or type the replacement in the
Change to box) and click Change All.

Click Add.

Click Suggest.

A deeper search takes longer but produces
better possible replacements. If the button

is unavailable, HotDocs is searching at the
deepest level.

Click Options. (You can also change your
options at the HotDocs Options dialog box.)
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Answer Files: Using Answer File Manager

Overview: Use Answer Management

By default, each answer file you create or use is managed through the Answer File Manager. The Answer
File Manager is similar to the HotDocs template library in that it allows you to organize your answer files
according to project specifications. It also lets you sort and search for answer files.

At times you may prefer to not use the Answer File Manager. For example, you can manage answer files
using a document manager instead of Answer File Manager. Or, if you have multiple users accessing the
same set of answer files, you can use Windows Explorer, since only one person can have write access to
Answer File Manager. (All other users have read-only access, which keeps them from saving or adding
answer files to the answer library.)
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Open and Close Answer File Manager

When you use Answer File Manager to manage your answer files, you have greater control over the
organization of your files (see Work with Answer File Manager). To use Answer File Manager, however,

you must first open it.

To open Answer File Manager

At the HotDocs library, click the @ Answer File Manager button. Answer File Manager appears.

To close Answer File Manager
= At Answer File Manager, click the X in the upper-right corner of the dialog box.

You can also open Answer File Manager by choosing Answer File Manager at the Tools
menu. To close Answer File Manager using the keyboard, press Alt+F4.
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Add an Answer File to Answer File Manager

Answer File Manager allows you to organize your answer files. When you save your answers after an
interview, a reference to the file is automatically added to Answer File Manager. When you need to use
answer files that someone else has created (or if you have created them while using Windows Explorer to
manage your files), you must add the files to Answer File Manager.

There are two ways to add an answer file to an answer library. You can import the answer file or you can

add it using the ﬁl Add button.

To import an answer file

1.

At Answer File Manager, click 'E' Import. The Import Answer File dialog box appears.
Browse to and select the file you want to import. HotDocs confirms you want to import the file.

Click Yes. The answer file is added to Answer File Manager. The file is also automatically included
in any answer file drop-down lists.

To add an answer file to Answer File Manager using Add

1.

At the HotDocs library window, click the I@ Answer File Manager button. Answer File Manager
appears.

Click the ﬁl Add button. The Add Item dialog box appears.

In the File name box, enter the path and file name of the answer file you want to use (or click —Jd
Browse to locate and open the file).

In the Title box, enter a name for the answer file. This title will identify the answer file in Answer File
Manager.

Optionally, in the Description box, enter a description to help you identify the answer file. (This
description appears at the Properties tab, and can be used when searching for specific answer
files.)

= If the answer file is located in folder other than the default Answers folder, you can import the
file, which copies the file to the default Answers folder and adds it to Answer File Manager. To do

this, click 'EI Import and then locate the answer file.
= When adding files to the library, press Ctrl or Shift to select multiple files at once.
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Work with Answer File Manager

Answer File Manager helps you organize answer files, much like a HotDocs library helps you organize

templates and clause libraries.

When you save answer files, they are added to Answer File Manager. Once added, you can organize
the files and modify the properties of the files. In addition, you can view an answer file's history—a list
of dates and times the answer file was used, including the template with which it was used. Finally, the

To display the Answer File Manager

Answer File Manager lets you preview the answers currently saved in an answer file.

1. Atthe template library, click the Answer File Manager button. The Answer File Manager dialog

box appears.

2. Complete any of the tasks described in the following table:

To
Create a new, empty answer file

Add an existing answer file to the library

Remove a reference to an answer file and
optionally delete the actual file from disk

Simultaneously copy an answer file you
receive to the Answers folder and add it to
the answer library

Sort answer files in alphanumeric order,
based on answer file titles

Search for a specific answer file

View the answers currently saved in an
answer file

View the history of when the selected
answer file was used to assemble various
templates

Do This

Click the IIEI New button. (See Create a New
Answer File.)

Click the ﬁl Add button. (See Add an Answer
File to Answer File Manager.)

To add multiple files one at a time, use Ctrl or
Shift to select several files.

Select the answer file, then click 'ﬁ_ﬂ Remove.

Click 'El Import. The Import Answer File
Name dialog box appears, where you can
browse to the answer file and select it. When
you click OK, the file is copied to the Answers
folder and added to the library.

i
Select a folder, then click the E.Jr Sort button.
The contents of the folder are reorganized.

Select Find, then type the text from the answer
file's title or description for which you are
searching in the text box. Only files that have
matching text in their title or description are
shown.

Select the answer file, then click the Contents
tab.

In the Contents tab, you can sort the columns
by clicking the column headings.

Select the answer file, then click the Properties
tab.
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Change the title, path, file name, history, or
description of an answer file

Add a folder so that you can better organize
groups of answer files

Modify a folder's title or description

Delete a folder

Move an answer file into a folder

Use Windows Explorer to access answer
files instead of Answer File Manager

v
Select the answer file, then click the @‘
Properties button and make the necessary
changes.

i Caution: Changing the file path does not

i change the location of the actual answer

i file. If you change the file path without using
i Windows Explorer to move the actual file to
i the new location, that answer file will not be
i accessible.

......................................................

Click the ﬁl Add button, then select Folder at
the Type drop-down box. (See Add, Modify, and
Delete Folders in Answer File Manager.)

et
Select the folder, then click A Properties.
(See Add, Modify, and Delete Folders in Answer
File Manager.)

Select the folder, then click {f‘_ﬂ Remove.
HotDocs asks what you want to do with any
answer files within the folder. (See Add, Modify,
and Delete Folders in Answer File Manager.)

Double-click the folder to open it, then select the
answer file and drag it to the folder.

Change the setting at the HotDocs Options
dialog box.
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Add, Modify, and Delete Folders in Answer File Manager

To help organize your answer files, you can place them in folders and subfolders within Answer File
Manager.

To add a new folder

1.

At the HotDocs library window, click the I@ Answer File Manager button. The Answer File
Manager appears.

Click the ﬁl Add button. The Add Item dialog box appears.

In the Type drop-down list, select Folder. The dialog box changes to show the options needed for
new folders.

In the Title field, enter a folder name.

Optionally, in the Description field, enter notes to explain why the folder was created, or what kinds
of answer files it contains. (This description appears at the Properties tab, and can be used when
searching for specific answer files.)

Click OK. The folder is added to the answer library. You can work with the folder using the following
commands:

To Do This

Move an answer file to a specific folder Double-click the folder to open it, then select an
answer file and drag it to the folder.

Modify the title or description ) If’ﬁq )

Select the folder and click the Properties

button. The Iltem Properties dialog box

appears, where you can change the title or

description.

Sort the contents of a folder in alphanumeric ) .&l

order Select the folder and click Z ¥ Sort. The
answer files are rearranged based on title.

Remove a folder Ly )
Select a folder and click Remove. If you

want to remove the items in the folder as

well, select Remove the unselected items
contained in the selected folders. Otherwise,
any files referenced in the folder will be moved
to the next folder level.
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